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Updates & Important Info 

Prints are 
BACK! 

Yes, Virginia – there is a Print Competition this year! As stated in our Image 
Evaluation Procedures, you may convert any image submitted as a digital 
image into a print for the EOY Competition. Look for a message from the 
Print Director for a time and place to deliver your prints. (They may be 
accepted at the October meeting.) 

Post-
Processing 
Update 

Because of the many new software options and upgrades, we have altered our 
requirements to allow you to make enhancements to exposure, color and 
tone, sharpening, contrast, cropping, cloning, minor retouching, and rotation 
for photos entered in all of the General Categories. These images must NOT 
contain elements from multiple photos and the final result should retain a 
realistic feel. 

Please enter your more creative efforts (combining multiple images, adding 
elements from other photos, substantial artistic enhancements, etc.) into the 
Assigned Subject or Creative Art Categories where the sky is the limit for edits. 

Deadline for 
Image 
Submission 

You must submit properly formatted and sized digital images (jpg files) for 
EACH image you wish to enter. Yes – we need a digital image for each print, 
also. These digital images are due by our EOY Deadline:  
                                   Midnight, October 15, 2022.  

Email them to our Digital Director: Digital.CCRVA@gmail.com. 

Permissions By entering this Competition, you agree to allow the publication/display of your 
images on the CCR website, facebook page, and in our monthly publication, 

“Southern Exposure”. 

Digital File 
Naming 

The general guidelines for file naming remain the same. Please reference the 
Digital File Naming section for the updated Assigned Subject abbreviations.  

Group 
Designations 

We have THREE Groups in which you may choose to compete. 

• Novice/Intermediate Group (Group N) 

• Advanced Group (Group A) 

• Expert Group (Group E) 

Please carefully assess where your photography skills rank as you 
determine at which level you should compete. You may move to a higher 
Group at any time. If you wish to move back to a lower Group, you must 
request and be approved by the CCR Board. 

EOY Judging End of Year Competition judging will take place on November 12, 2022. 

EOY Awards 
Presentation 
& Banquet 

Plans are underway for a return to our Annual Banquet this year where 
winners will be announced. Please note: The event will be held on 
Wednesday, December 7, 2022. This is the FIRST Wednesday in 
December. Winners will receive official certificates acknowledging their 
achievements. Memorial (Best) Awards will receive trophies. 

mailto:Digital.CCRVA@gmail.com
https://www.cameraclubofrichmond.com/
https://www.facebook.com/CameraClubOfRichmond
https://www.cameraclubofrichmond.com/ccr-newsletter---southern-exposure
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Points & 
Scores 

As in the past, three top photography experts assign numerical ratings of up to 
9 Points to each image, for a maximum Score of 27 Points.  

The Scores (Total Points) for each image are then used to rank the entries in 
each Judging Block (Category, Color Designation, Media Type, and 
Group) from highest to lowest to determine 1st, 2nd, and 3rd Places, as well as 
Honorable Mentions. Any resulting ties within the Judging Blocks are 
immediately decided by the Judges in additional rounds of judging. 

Minimum 
Total Score 

Utilizing the Judges’ Scores, the EOY Team will apply a Minimum Total 
Score (MTS) threshold, so ALL qualifying images are recognized within their 
respective Judging Block (Category, Color Designation, Media Type, and 
Group). The Novice/Intermediate Group’s Score threshold is lower than the 
Advanced Group’s, and the Expert Group has the highest Score requirement.  

As Judges – and therefore Scores - vary from year-to-year, final MTSs for 
each Group will be determined by the Board after the judging so that 
approximately 20-25 % of the images will receive Awards. 

The number of Awards within a Judging Block is determined by how many 
photographs meet these qualifications – NOT by how many photos are 
entered (as in the past). If no entries within a Category reach the Minimum 
Total Score threshold, then no Awards will be given.  

Credits Beginning in 2021, Members began accumulating Credits based on the 
number of Awards won. These Credits will be accumulated over no more than 
a running 3-year timeframe.  

Credit Amounts: 

• 1st Place = 3 Credits 

• 2nd Place = 2 Credits 

• 3rd Place = 1 Credit 

• Honorable Mention = 0 Credits 

• Major Awards = 0 Credits 

Group 
Advancement  

Members will advance to a higher Group based on the Credits accumulated 
over a running 3-year timeframe. 

Advancement Criteria 

• Novice/Intermediate Group advances at 25 or more total Credits 

• Advanced Group advances at 30 or more total Credits 

Once a photographer advances to a higher Group, s/he starts over with 0 
Credits. ANY photographer may self-advance into a higher Group if s/he 
wishes. Once a photographer moves to a higher Group, s/he may only 
move downward by petitioning the CCR Board for approval. 

A Board Member may contact you to recommend a Group change based 
on the Credits you accumulated in prior EOY Competitions. 
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General Rules 

1. Photographers submitting images for the EOY Competition must be Camera Club of 
Richmond Members in good standing, having paid the current year Membership Dues: $40. 

2. The Camera Club of Richmond’s End of Year Competition allows each Member to enter up to 
TWELVE images in the contest and are subject to these rules: 

• Images that are submitted throughout the year into *Image Evaluations are called 
Standard Images, and you may enter up to twelve. 

• You may opt to substitute up to FIVE images that were NOT previously evaluated. 
These images are called Wildcards. 

3. All submissions, camera work (including staging and post-production), as well as any 
“creative changes” must be the work of the photographer submitting the image. 

4. Images made while under the immediate direction or technical supervision of another 
person are not eligible. (For example, being given specific exposure and technical 
settings by an instructor while attending a photo outing, seminar, class, trip, or safari are not 
eligible.) 

5. An image may only be entered once into a single EOY Competition. (For instance, the 
image may not be entered as both a B&W and a Color image, or into different Categories.) 

6. Images may NOT include the photographer's name on the face of the image. 

7. Entries must be submitted with the proper Digital File Name and correct format. 

8. You may also add a digital frame or mat to your submission to give it a “finished” 
presentation. See Anthony Rumley’s Video on CCR’s YouTube channel for instructions. 

9. Post Processing Guidelines: 

• In the General Categories (Animals, Architecture, Flora, Landscape, Pictorial, and 
Portrait), images may be edited, however, post-processing may be used only to 
enhance the existing image to ensure realism. Enhancements are allowed to 
exposure, color and tone, sharpening, cloning, minor retouching, contrast, cropping, and 
rotation. You may NOT combine elements from multiple images. 

• The Special Categories (the 3 Assigned Subjects and Creative Art) are intended to 
show each photographer’s creativity and skills to enhance an image. You may combine 
elements from multiple images and use unlimited post-processing, including filters and 
creative imaging software. Images in these Categories are judged on their imagination, 
creativity, uniqueness, and editing. 
 

*The Camera Club of Richmond (CCR) offers six Image Evaluations to our Members each year. 
Members are invited to submit one or two images that are reviewed and critiqued by a 
seasoned/professional photographer during those designated monthly meetings. 

https://www.cameraclubofrichmond.com/image-evaluations
https://www.youtube.com/watch?v=iGLlhrQyf_M&t=24s
https://www.cameraclubofrichmond.com/image-evaluations
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Category Names, Abbreviations, & Descriptions 

Animals 
(AN) 

Animal photography traditionally refers to images of undomesticated animal species 
that normally live in the wild. Animal Photography documents various forms of wildlife in 
a natural or simulated habitat. An example of simulated habitat would be an image of a 
captive animal in a zoo that does not show cages, buildings, or other manufactured 
construction not present in its natural surroundings. The incidental presence of animals 
(e.g., distant birds, cattle, etc.) or manufactured objects (e.g., distant fences, vehicles, 
etc.) is acceptable. 

Architecture 
(A) 

Architectural photography is the photographing of buildings and similar manufactured 
structures that are accurate representations of their subjects. 

Creative Art 
(CA) 

Creative Art is an extension of conventional photography and post-processing into 
creative art. Its purpose is to stimulate those creative thoughts and encourage 
experimentation with innovative ideas going beyond a simple photograph. 

Flora  
(F) 

Flora photography is a photograph of plant life occurring in a particular region or 
timeframe.  

Landscape  
(L) 

Landscape photography shows spaces within the world, sometimes vast and unending, 
but other times of a smaller scope. Landscape photographs typically capture the 
presence of nature (e.g., panoramic views of the Grand Canyon, or a Seascape) with a 
primary emphasis on the natural subjects. A Landscape can also focus on 
manufactured features or disturbances within the natural landscapes (e.g., Richmond 
Skyline from the Flood Wall, etc.) 

Portrait 
(PO) 

Portrait photography is a photograph of a person or group of people that captures the 
personality, traits, or features of the subject by the use of effective lighting, backdrops, 
poses, direction, or post-processing. Street Photographs meeting these criteria may 
also qualify as Portraits. 

Pictorial  
(PI) 

Pictorial photography is a general photography Category. It might be a still-life image, a 
casual picture of a person or pet (not a formal portrait), street photography, travel 
images, photojournalism, or any image not previously addressed in another Category. 
This would be the Category for pet photography, whether posed or just spontaneous. 

Assigned 
Subjects 

(AS_P) 
(AS_A) 
(AS_T) 

Any image previously submitted to a Monthly Image Evaluation as an Assigned Subject. 
The Assigned Subjects for 2022 are: 

Photojournalism or Street Photography 
Abandoned 
About Time 

 

Submitted images that do not meet the requirements of the Category 

 may be disqualified at the Judges’ discretion. 

https://en.wikipedia.org/wiki/Domestication
https://en.wikipedia.org/wiki/Animal
https://en.wikipedia.org/wiki/Species_(biology)
https://en.wikipedia.org/wiki/Wildlife
https://en.wikipedia.org/wiki/Nature
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Color Designations 

Images may be submitted as either Color Images or Black and White Images. 
 

Color (C) Color images are shot in full color or contain any color other than black & white. 

Black & White 
(BW) 

Black & White images are monochrome images, including infrared photographs, 
produced in black and white or in varying tones of only one color. Images that 
are primarily monochrome but contain added color to part of the image should 
be submitted as Color, NOT as B&W. 

 

Color Designations are judged separately for each Category, Media Type, and Group. 
 
 

Media Types 
Images may be submitted as either Digital Images or Prints. 

 

Digital Images 
(D) 

Digital images must be submitted as .jpg files. Refer to these sections for 
additional instructions: 

Resizing Images in Adobe Lightroom 

Resizing Images in Adobe Photoshop 

See the Digital Submission Rules for specific guidelines on submitting digital 
images. 

Prints 
(P) 

Prints must be mounted, matted, or printed onto any material that allows the 
image to be freestanding in the light box. Refer to the Print Submission Rules 
for specific guidelines on preparing and submitting Prints. 

 

Media Types are judged separately for each Category, Color Designation, and Group. 
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Groups and Group Advancement 

Groups 

CCR has THREE Groups in which you may choose to compete:  

Group Name Description 

Novice/Intermediate 
Group N 

New CCR Members or Members who have not entered a prior EOY 
Competition who feel they are just beginning to learn photography skills. 

Advanced 
Group A 

Members who feel that they have advanced photography skills beyond 
the novice or intermediate level. 

Expert 
Group E 

Members who have well-developed photography skills, consistently 
placing 1st, 2nd, or 3rd in prior EOY Competitions. 

All new Members, and those who have never competed before in a CCR EOY Competition, are 
invited to join and compete in the Novice/Intermediate Group. However, you may choose to jump 
into any Group you wish for your first Competition. Any Member may move to a higher Group at any 
time. However, if a Member wishes to move back to a lower Group, s/he must request and be 
approved by the CCR Board. 

Groups are judged separately for each Category, Color Designation, and Media Type. 

Group Advancement 
Beginning in 2021, Members began accumulating Credits based on the number of Awards won.  

Credit Amounts: 

• 1st Place = 3 Credits 

• 2nd Place = 2 Credits 

• 3rd Place = 1 Credit 

• Honorable Mention = 0 Credits 

• Major Awards = 0 Credits 

These Credits will be accumulated over no more than a running 3-year timeframe. When an 
individual’s Credit Totals reach the benchmark amount, the Member graduates to the next Group.  

Advancement Criteria 

• Novice/Intermediate Group graduates at 25 or more total Credits 

• Advanced Group graduates at 30 or more total Credits 

Once a Member advances to a higher Group, s/he starts over with 0 Credits. ANY photographer may 
self-advance into a higher Group if s/he wishes. Once a photographer moves to a higher Group, 
s/he may only move downward by petitioning the CCR Board for approval. 

As the EOY Team prepares for each Competition, a Member of that team may contact certain 
Members to recommend a Group change based on the Credits they have accumulated in prior 
EOY Competitions. 

https://www.cameraclubofrichmond.com/eoy-competition
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Scoring & Minimum Total Scores 

 

Scoring 
As in the past, three top photography experts will assign Points to each image submitted. Points 
can range from 3 to 9 Points for each image - for a maximum total of 27 Points per image.  

Those Scores are then used to rank the entries in each Judging Block from highest to lowest to 
determine 1st, 2nd, and 3rd Places, as well as Honorable Mentions. Any resulting ties within the 
Judging Blocks are immediately decided by the Judges via additional rounds of judging. 

 

Minimum Total Score 
In 2021, following the lead of several other photography associations and clubs, CCR changed the 
way we determine Awards for images submitted to our EOY Competition. Instead of assigning 
Awards based on the number of entries in each Judging Block, the CCR Board voted to refocus 
our emphasis on merited images, so that all meritorious images are recognized.  

In our merit-based system, each Group is assigned a Minimum Total Score (MTS). Those MTS 
levels will increase commensurate with Group skill levels (i.e., the Novice/ Intermediate MTS will be 
lower than Advanced; and Advanced will be lower than Expert.) 

• All images meeting this MTS threshold for a Judging Block (Category, Color Designation, 
Media Type, and Group) will earn Awards.  

• The Judges will immediately break any ties via additional rounds of judging. 

• If all three of the highest scoring images meet the MTS, then 1st, 2nd, and 3rd Place Awards are 
given, regardless of how many images are entered.  

• Any additional images meeting the MTS are awarded Honorable Mentions. 

• Awards for Assigned Subjects: 
o All Groups are judged together in the each of the three Assigned Subject Categories. 
o 1st, 2nd, and 3rd Place Awards will be given. 
o Honorable Mentions will be awarded based on the MTS for each Group. 

As Judges – and therefore Scores - vary from year-to-year, final MTSs for each Group will be 
determined by the CCR Board after the judging so that approximately 20-25% of the images 
will receive Awards. 

Note: If no entries in a Judging Block (Category, Color Designation, Media Type, and Group) 
meet their MTS, then no Awards will be given. 
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Credits 
Beginning in 2021, Members began accumulating Credits based on the number of Awards won. 
These Credits will be accumulated over no more than a running 3-year timeframe. When an 
individual’s Credit Total reaches the benchmark amount, they will graduate to the next Group.  

Credit Amounts: 

• 1st Place = 3 Credits 

• 2nd Place = 2 Credits 

• 3rd Place = 1 Credit 

• Honorable Mention = 0 Credits 

• Major Awards = 0 Credits 
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Submission Criteria 

Digital Submission Rules 

The Digital Director needs digital files to organize the hundreds of images being judged. In 
addition, the CCR Webmaster will create a Member Gallery of all winning images on the CCR 
Website and images may be featured on the CCR facebook page and in our monthly publication, 
“Southern Exposure”.  

You must submit a properly formatted and sized digital images by the EOY deadline:  
Midnight, October 15, 2022. 

There are the two basic specifications: 

• Digital images must be in jpg format. 

• The longest side of your digital image must not exceed 1920 pixels. 

If you need additional instructions, please see separate procedures for: 

• Resizing Digital Images in Adobe Lightroom 

• Resizing Digital Images in Adobe Photoshop 

Digital File Naming 

Digital images must be properly named so that the hundreds of submissions can be more easily 
sorted and evaluated. Be sure to change your digital file name to follow this Naming Convention 
when submitting your digital images: 

[Media Type]_[Category Abbreviation]_[Color Designation]_[Group]_ 
[Title of Image]_[Standard or Wildcard]_[Your Name].jpg 

OMIT the Brackets ([]) 

INCLUDE the Underscores (_) 

INCLUDE any necessary Spaces or Dashes in Your Name and your Image Title. 

Use only jpg file type. 

For example, this file name: 

D_AS_T_BW_A_Time-Sensitive_ST_Karen Davis.jpg 

would represent a  
[D]igital Image 

[AS_T] Assigned Subject: About Time Category 
[BW] Black & White Image 

Group [A] 
Entitled: Time-Sensitive 

[ST] Standard Image (Previously submitted to an Image Evaluation) 
By Photographer: Karen Davis 

https://www.cameraclubofrichmond.com/f724689840
https://www.facebook.com/CameraClubOfRichmond/
https://www.cameraclubofrichmond.com/ccr-newsletter---southern-exposure


 

 

2022 End of Year Competition  
 

Revised: September 1, 2022 
 

Karen Taylor Davis Back to Table of Contents 11 

Digital File Delivery 

All digital images must be emailed to the Digital Director by MIDNIGHT, October 15, 2022, at this 
address: Digital.CCRVA@gmail.com. Email your jpg files (2 or 3 at a time): 

  To: Digital.CCRVA@gmail.com  

  Subject: EOY Competition  

  Click the paperclip icon to attach your digital files. Do not imbed photos in the body of your email. 

You’ll receive an automated confirmation from the Digital Director. If you have not received this 
confirmation by the next day, you should contact him/her to verify that your files were received. 

Print Submission Rules 

Prints are evaluated on a light box, according to Photographic Society of America (PSA) rules. 

Prints must be at least 5” x 7” and no larger than 16” x 30” in size (including any mat).  

Prints must be mounted, matted, or printed onto any material that allows the image to be 
freestanding in the light box. 

Make sure that the method for adhering the printed image to the backing cannot be seen on the 
front of the image. (Please no scotch-taped corners.) 

Framed prints are not allowed. 

Attach a completed copy of the EOY Print Form to the upper-left corner of the back of the mat. 
Please ensure that all writing is legible. 

Look for a message from the Print Director for a time and place to deliver your prints. (They 
may be accepted at the October meeting if you have them ready by then.) 

Digital File Requirement for Prints 

If you are submitting a print, you must also submit a properly formatted and sized digital 

image by the EOY deadline: Midnight on the 3rd Saturday in October. The Digital Director 
needs these digital files to organize the hundreds of images (prints and digital) being judged. 

S/He creates a list of all prints submitted, then forwards that, along with those image files to 
the Print Director. This helps the Print Director organize the prints for the Judges. 

In addition, the CCR Webmaster will create a Member Gallery of all winning images on the 

CCR Website and we will highlight these winners on our CCR facebook page. 

For Help 

If you need help, feel free to contact any of our CCR Board Members, starting with: 

   Digital Director: Digital.CCRVA@gmail.com 

   Print Director: Prints.CCRVA@gmail.com 
a 

mailto:Digital.CCRVA@gmail.com
mailto:Digital.CCRVA@gmail.com
https://psa-photo.org/
https://www.cameraclubofrichmond.com/print_form_eoy.pdf
https://www.cameraclubofrichmond.com/f724689840
https://www.facebook.com/CameraClubOfRichmond
https://www.cameraclubofrichmond.com/ccr-directors.pdf
mailto:Digital.CCRVA@gmail.com
mailto:Prints.CCRVA@gmail.com
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End of Year Awards 
In 2021, following the lead of several other photography associations and clubs, CCR changed the 
way we determine EOY Awards for our images.  

We are now putting the emphasis on Merited Images, so that all meritorious images are recognized; 
Instead of assigning Awards based on the number of entries in each Judging Block as we have 
done in the past, the CCR Board now assigns a Minimum Total Score (MTS) for each Group. Those 
MTS levels will increase commensurate with the skill levels (i.e., Novice/Intermediate MTS will be 
lower than Advanced; and Advanced will be lower than Expert.) 

• All images meeting the MTS threshold for its Judging Block will earn Awards.  

• The Judges will immediately decide any ties via additional rounds of judging. 

• If all three of the highest scoring images meet the MTS, then 1st, 2nd, and 3rd Place Awards are 
given. 

• Any additional images meeting the MTS will be awarded Honorable Mentions. 

• Awards for Assigned Subjects: 
o All Groups are judged together in the three Assigned Subject Categories. 
o 1st , 2nd, & 3rd Place Awards are given to the three images with the highest Point scores. 
o Honorable Mentions will be awarded according to the MTS for each Group. 

Winners of these EOY Awards will receive a lovely certificate (suitable for framing!) acknowledging 
this achievement. 

Note: If no entries in a Judging Block meet the Minimum Total Score, no Awards will be given. 

 

Memorial (Best) Awards 

The EOY Judges will select six outstanding images for the Camera Club of Richmond’s Memorial 
(Best) Awards. The winners of these Awards will receive trophies (to grace their bookshelves!) 
 

Award: Name Given to the Award: 

Best Color Digital W.A. Yoder Award 

Best B&W Digital Phillip Luce Award 

Best Color Print Stanley Balderson Award 

Best B&W Print Edwin Booth Award 

Best Assigned Subject Hyman Rose Award 

Best in Show Bernard Howell Award 
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References, Support, & Helpful Hints  

FROM A JUDGE’S POINT OF VIEW 

1. Overall 
Impact/ 
Impression 

Does the image tell a “story” and is the subject of the image 
appropriate to the story? Does the image evoke emotion? Does the 
image have a “wow” factor? 

2. Technical 
Factors 

Does the image display focus, depth of field, exposure, lighting, 
contrast, and color balance (or tonal scale in black and white images) 
that are appropriate to the subject matter and the “story” being told by 
the photographer? 

3. Creativity Is the photo original and fresh in composition and/or in the use of 
lighting, perspective, color, special effects, etc.? 

4. Composition Is the design of the image visually pleasing or disturbing depending on 
the intent of the photographer? Do the elements of the image hold the 
observer and easily draw him/her to its subject? Does the composition 
come together as a whole, providing balance or lack thereof as 
appropriate to subject matter and the “story”? 

5. Finishing If present, do physical or digital mats, borders, vignetting, etc. add to 
the photo or distract from it? 

 

Remember that each Evaluator and Judge is expressing his or her own personal opinion and that 
“Beauty is in the eye of the Beholder” – AND the Photographer! 
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HOW DO I SELECT A CATEGORY? 

The selection of a Category for your award-winning image can be a daunting task. If you enjoy 
surfing the net there are numerous articles, statements, and self-proclaimed authorities who describe, 
define, and declare what is right and what is wrong. Nevertheless, this is time-consuming and 
confusing at best. 

One method, used by pros and amateurs, is to ask yourself a few personal questions about your 
motive for capturing that image. For example, was your motive to: 

• Shoot that elusive tiger on your African Safari? He would be in Animals. 

• Document a historical cathedral? Then, it would fit into Architecture. 

• Preserve the color and texture of a beautiful blossom? This would be Flora.  

• Show the magnitude of a vast desert? This would be a Landscape. 

• Tell a story or show an event? This would be Pictorial. 

• Capture the beauty or emotion of a particular individual? This is a Portrait. 

• Combine multiple images and/or demonstrate your post processing skills? This would be 
Creative Art. 

 
If you answer your “motive” question honestly, you will probably select the correct Category. 
 
Our six General Categories are: 

• Animals  

• Architecture 

• Flora 

• Landscape 

• Pictorial 

• Portrait 

 
A seventh, Special Category exists to allow unlimited, creative post-processing edits: 

• Creative Art 
 

At the beginning of each year, the CCR Board announces three special Categories referred to as 
“Assigned Subject” Categories for that year. The intent is to challenge our Photographers to try 
something new or stretch their post processing skills (since these Categories also allow unlimited, 
creative post-processing edits). This year, those Categories are: 

• Photojournalism or Street Photography 

• Abandoned 

• About Time 
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GLOSSARY OF IMPORTANT TERMS 

Assigned 
Subjects 

At the beginning of each year, the CCR Board announces three special 
Categories referred to as Assigned Subject Categories for that year. The 
intent is to challenge our photographers to try something new or stretch their 
post processing skills (since these Categories allow unlimited post-
processing creativity).  

Black & White 
Images 
[BW] 

The Color Designation BW refers to Black & White images. They are 
monochrome images, including infrared photographs, produced in black and 
white or in varying tones of only one color. Images that are primarily 
monochrome but contain added color to any part of the image should be 
submitted as Color, NOT as B&W. 

Camera Club of 
Richmond 
Member 

A CCR Member is one who has paid Membership Dues for the current year. 
All CCR Members are eligible to submit images for Image Evaluations (held 
during six times per year at monthly CCR Meetings) as well as participate in 
the End of Year Competition. 

Camera Club of 
Richmond Dues 

CCR dues for FULL Membership in the club are $40. 

Please note: Membership in CCR MeetUp (MeetUp.com/Camera-Club-of-
Richmond) is free, however if you only belong to CCR MeetUp, you are 
NOT eligible to submit images for Image Evaluations or participate in the 
End of Year Competition. 

Categories These are the general groups to which you will submit your images for the 
End of Year Competition. See the official Category list for guidance on 
where to place your photos or contact any CCR Board Member for help. 

Color Designation Color Designation refers to the range of colors contained in your image. 

Black & White (BW) images are monochrome images, including infrared 
photographs, produced in black and white or in varying tones of only one 
color. Images that are primarily monochrome but contain added color to part 
of the image should be submitted as Color, NOT as Black & White. 

Color (C) refers to images shot in full color or containing any color other than 
black and white. 

Color Images 
[C] 

The Color Designation Color refers to images shot in full color or containing 
any color other than black and white. 

 
 
 
 

https://www.cameraclubofrichmond.com/image-evaluations
https://www.meetup.com/Camera-Club-of-Richmond/
https://www.meetup.com/Camera-Club-of-Richmond/
https://www.cameraclubofrichmond.com/image-evaluations
https://www.cameraclubofrichmond.com/ccr-directors.pdf


 

 

2022 End of Year Competition  
 

Revised: September 1, 2022 
 

Karen Taylor Davis Back to Table of Contents 16 

Credits Beginning in 2021, CCR added a new dimension to our EOY Competition. 
The Awards earned are assigned Credits: 

• 1st Place = 3 Credits 

• 2nd Place = 2 Credits 

• 3rd Place = 1 Credit 

• Honorable Mention = 0 Credits 

• Major Awards = 0 Credits (since they received 3 Credits for 1st Place) 

Photographers will accumulate Credits to determine when they graduate to a 
higher Group. Records are being kept beginning with the 2021 EOY 
Competition and will be cumulative within each Group for a running 3-
year timeframe.  

Note: Credits earned as a “Novice/Intermediate” are used to determine when 
to move up to “Advanced.” Once there, you begin again with “0” and 
accumulate “Advanced Credits” to determine when you move to “Expert”.  

End of Year 
Competition 
(EOY) 

CCR holds a Competition at the end of each year and invites Members to 
submit up to twelve photographs to compete for Awards in several different 
Categories. Up to five of those photos may be Wildcard Images. The other 
images (called Standard Images) must have been evaluated at one of the 
monthly CCR Image Evaluations during the current year. 

These photos are due in October and judged by a panel of experienced 
photographers – usually from outside the Richmond area – in November. 
Awards are presented at our CCR Awards Presentation (and hopefully, a 
Banquet!) which is held in place of our regular CCR meeting on the first or 
second Wednesday in December (depending on venue availability). 

EOY Groups 

 
[N] 

 
 

[A] 

 

 
 

[E] 

CCR now offers THREE Groups in which our photographers will vie for 
Awards in our EOY Competition 

Novice/Intermediate – Group N 

This group is for new/novice CCR Members who feel they are just beginning 
to learn their photography skills. 

Advanced - Group A 

This Group is for Members who feel that they have advanced photography 
skills beyond the novice or intermediate level. 

Expert - Group E 

This Group is for Members who feel that they have “expert” photography 
skills, consistently placing 1st, 2nd, or 3rd in prior EOY Competitions. 

ANY photographer may self-select into a higher Group if s/he wishes.  

Once a photographer moves to a higher Group, s/he may only move 
downward by petitioning and being approved by the CCR Board. 

https://www.cameraclubofrichmond.com/image-evaluations
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Image Evaluations Six times a year, CCR holds an Image Evaluation during our regular Monthly 
Meeting. CCR Members (who have paid their Annual Dues) are invited to 
submit 1 or 2 images for review. We invite a professional/experienced 
photographer or local artist to review these images and provide constructive 
feedback to help us learn and improve as photographers. 

JPG JPG stands for Joint Photographic Experts Group. JPG is the standard file 
format for compressing digital images so they can be stored or sent by email 
more easily. CCR requires that all images submitted for Image Evaluations 
and End of Year Competition are in the JPG file format (extension “.jpg”). 

JPEG Please do NOT use the “JPEG” file extension on your digital files. 
Please DO use the “.jpg” extension. 

Judging Block A Judging Block is just a convenient way to label the collective images that 
are competing with each other. It is the block of images that are judged 
together as determined by  

Category, Color Designation, Media Type, and Group. 

For instance: 

Color, Prints in the Animal Category, for the Expert Group 
are judged separately from the 

B&W, Prints in the Animal Category, for the Expert Group. 

Thus, separate Judging Blocks will be created for  
every combination of the four factors listed above. 

Media Type 
[D] 
(P) 

Media Type indicates whether the image is entered as a: 
Digital Image, or a 
Print. 

Detailed submission requirements are in the: Digital Submission Rules. 

Minimum Total 
Score (MTS) 

In 2021, following the lead of several other photography associations and 
clubs, CCR changed the way we determine Awards for images submitted to 
our EOY Competition. Instead of assigning Awards based on the number of 
entries in each Category, the CCR Board voted to refocus our emphasis on 
merited images, so that all meritorious images are recognized.  

Each Group is assigned a Minimum Total Score (MTS). Those MTS levels 
will increase commensurate with the skill levels (i.e., Novice/ Intermediate 
MTS will be lower than Advanced; and Advanced will be lower than Expert.) 

• All images meeting this MTS threshold for a Judging Block (Category, 
Color Designation, Media Type, and Group) will earn Awards.  

• The Judges will immediately break any ties via additional rounds of 
judging. 

https://www.cameraclubofrichmond.com/image-evaluations


 

 

2022 End of Year Competition  
 

Revised: September 1, 2022 
 

Karen Taylor Davis Back to Table of Contents 18 

• If all three of the highest scoring images meet the MTS, then 1st, 2nd, and 
3rd place Awards are given, regardless of how many images are entered.  

• Any additional images meeting the MTS will earn Honorable Mentions. 

• Awards for Assigned Subjects: 
o All Groups are judged together in the Assigned Subject Categories. 
o 1st, 2nd, and 3rd Place Awards will be given. 
o Honorable Mentions are awarded based on the MTS for each Group. 

As Judges – and therefore Scores - vary from year-to-year, final MTSs 
for each Group will be determined by the CCR Board after the judging 
so that approximately 20-25% of the images will receive Awards. 

Note: If no entries in a Category/Color Designation/Group meet their 
MTS, then no Awards will be given. 

Naming 
Convention for 
EOY Competition  

There is a specific way that images must be named for the EOY Competition, 
so that the hundreds of submissions can be more easily sorted and judged. 
You must change your digital file name to follow this Naming Convention 
when submitting your digital images: 

[Media Type]_[Category Abbreviation]_[Color Designation]_[Group]_ 
[Title of Image]_[Standard or Wildcard]_[Your Name].jpg 

OMIT the Brackets ([]) 

INCLUDE the Underscores (_) 

INCLUDE any necessary Spaces or Dashes in Your Name and your 
Image Title. 

Use only jpg file type. 

For example, this file name: 

D_AS_T_BW_A_Time-Sensitive_ST_Karen Davis.jpg 

would represent a  
[D]igital Image 

[AS_T] Assigned Subject: About Time Category 
[BW] Black & White Image 

Group [A] 
Entitled: Time-Sensitive 

[ST] Standard Image (Previously submitted to an Image Evaluation) 
By Photographer: Karen Davis 

Standard Images 
[ST] 

Standard Images are those images that were submitted for Image 
Evaluations during the current year.  

Assigned Subject images must be submitted for an Evaluation in the current 
year; thus, they are ALWAYS considered Standard Images. 

You may submit up to 12 Standard Images for the EOY Competition. 

https://www.cameraclubofrichmond.com/image-evaluations
https://www.cameraclubofrichmond.com/image-evaluations
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Points & Scores Three top photography experts assign scores of up to 9 Points to each 
image, for a maximum Score of 27 Points.  

The Scores (Total Points) for each image are then used to rank the entries in 
each Judging Block from highest to lowest to determine 1st, 2nd, and 3rd 
Places, as well as Honorable Mentions. Any resulting ties within the Judging 
Blocks are immediately decided by the Judges in additional rounds of 
judging. 

Wildcard Images 
[WC] 

Wildcard Images are those images that were NOT submitted for an Image 
Evaluation during the current year.  

FIVE of the images you submit for the EOY Competition may be Wildcards.  

For an Assigned Subject to be submitted for the EOY Competition, it MUST 
have been previously submitted for an Image Evaluation during the current 
year. In other words, there can be no Wildcard submissions into Assigned 
Subjects. 

And yes – you may submit just the five Wildcard images if you wish. There is 
no requirement to submit Standard Images at all. 

  

https://www.cameraclubofrichmond.com/image-evaluations
https://www.cameraclubofrichmond.com/image-evaluations
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RESIZING IMAGES IN ADOBE LIGHTROOM 

Why do I need to resize my images? 

CCR Accepts digital images for the following:  

• Image Evaluations at Monthly Meetings 

• End of Year Competition 
• Online Member Photo Galleries 

• Monthly Southern Exposure 
• CCR facebook page (we request a watermarked version for facebook) 

All images submitted for any of the above must be as close to and cannot exceed 1920 pixels 

on the longest side of that image. Before resizing your image, be sure ALL IMAGE EDITING IS 
COMPLETE and you are ready to submit your image. 

How do I resize my images in Adobe Lightroom? 

Open Lightroom and select the image you want to resize. 

Select File > Export. You will see the following screen: 

  
 

Follow these guidelines for each of the fields: 

File Naming Custom Name This is where you can rename your file according to the 

proper Naming Convention. 

https://www.cameraclubofrichmond.com/image-evaluations
https://www.cameraclubofrichmond.com/f348515942
https://www.cameraclubofrichmond.com/f348515942
https://www.cameraclubofrichmond.com/ccr-newsletter---southern-exposure
http://www.facebook.com/?CameraClubofRichmond
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 Custom Text Enter your new file name in this box. 

Video No Action  

File Settings Image Format JPG 

 Color Space sRGB 

 Limit File Size to N/A 

Image Sizing ✓ Resize to Fit Width & Height 

 W: 

H: 

Make sure the longest edge of your image is 1920 
pixels. The other dimension will recalculate 

automatically. 

 Resolution Use Default 

Output 

Sharpening 

✓ Sharpen for Screen 

Metadata No Action  

Watermarking No Action Be sure NOT to watermark your image. Names may not 
appear on the front of any image submitted for 

Evaluation or Competition. 

Post 

Processing 

No Action This is your choice as to whether you want to see the 

image once you are done. 

Click the Export button. Your file will export to the directory you specified on your computer 

and is now ready to email to the Digital Director: Digital.CCRVA@gmail.com.  

What if I need help? 

If you need help, feel free to contact any of our CCR Board Members, starting with: 

Digital Director: Digital.CCRVA@gmail.com  

Print Director: Prints.CCRVA@gmail.com 

 
  

mailto:Digital.CCRVA@gmail.com
https://www.cameraclubofrichmond.com/ccr-directors.pdf
mailto:Digital.CCRVA@gmail.com
mailto:Print.CCRVA@gmail.com
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RESIZING IMAGES IN ADOBE PHOTOSHOP 

Why do I need to resize my images? 

CCR Accepts digital images for the following:  

• Image Evaluations at Monthly Meetings 
• End of Year Competition 

• Online Member Photo Galleries 
• Monthly Southern Exposure 
• CCR facebook page (we request a watermarked version for facebook) 

All images submitted for any of the above must be as close to and cannot exceed 1920 pixels 

on the longest side of that image and should be under 1 MB (1000K) in size. 

Before resizing your image, be sure ALL IMAGE EDITING IS COMPLETE and you are ready to 
submit your image for Evaluation/Competition. 

How do I resize my images in Adobe Photoshop? 

Open Photoshop. 

Select File and choose the image you want to resize. 

Select Open and your image will appear. 

Select Image > Image Size.  

You will see this menu: 

 

Adjust the Pixel Dimensions to 1920 Pixels for the longest side: 

• Width for a Horizontal Image 
• Height for a Vertical Image 

The other dimension is calculated automatically. 

Resolution: Use the default. 

https://www.cameraclubofrichmond.com/image-evaluations
https://www.cameraclubofrichmond.com/f348515942
https://www.cameraclubofrichmond.com/f348515942
https://www.cameraclubofrichmond.com/ccr-newsletter---southern-exposure
http://www.facebook.com/?CameraClubofRichmond


 

 

2022 End of Year Competition  
 

Revised: September 1, 2022 
 

Karen Taylor Davis Back to Table of Contents 23 

Click OK. 

Your image may appear smaller on your screen. 

Select File > Save As and name your file into the proper Naming Convention. 

You will then see this window: 

 

Click OK. 

Your image will save to the folder you specified on your hard drive and is now ready to email 
to the Digital Director: Digital.CCRVA@gmail.com. 

What if I need help? 

If you need help, feel free to contact any of our CCR Board Members, starting with: 

Digital Director: Digital.CCRVA@gmail.com  

Print Director: Prints.CCRVA@gmail.com 

 

  

mailto:Digital.CCRVA@gmail.com
https://www.cameraclubofrichmond.com/ccr-directors.pdf
mailto:Digital.CCRVA@gmail.com
mailto:Prints.CCRVA@gmail.com
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FREQUENTLY ASKED QUESTIONS – AND ANSWERS! 

My Question: The Answer: 

Who can enter the End of Year (EOY) 
Competition? 

Current, paid Camera Club of Richmond (CCR) Members 
may enter. Dues are $40 per year. 

Are there any restrictions on the photos I 
enter? 

Yes. Refer to the previously stated General Rules. 

How many photos may I enter? You may enter up to twelve (12) images. 

You are allowed up to FIVE (5) images that have not been 
previously evaluated this year (known as Wildcards). 

Any other images (referred to as Standard Images) must 
have been critiqued at one of the monthly CCR Image 
Evaluation meetings. 

What is a Wildcard Image? Wildcards are images that have NOT been evaluated at 
one of the current year’s Image Evaluations. Up to five of 
the images you submit may be Wildcard images. 

May I submit prints as well as digital images? Yes, you may enter any combination of prints and digital 
images up to the twelve images allowed. 

What if I did not participate in the monthly 
Image Evaluations; can I still enter the EOY 
Competition? 

Yes. Since you did not enter any previously evaluated (i.e., 
Standard) images, you may still enter up to five images as 
Wildcards. The reason for the rule is to encourage 
everyone to submit images during the year to learn from 
the preliminary Image Evaluations. 

Do we differentiate images between Color 
and Black & White? 

Yes. You will enter your images into either the Color or 
Black & White Color Designation. 

Who determines the Category in which my 
images are judged? 

Each photographer assigns a Category to each of his/her 
photos based on the Category descriptions. 

If you are unsure which Category to select, please consult 
with one of the CCR Board Members for advice. If the 
Judges determine that an image does not meet the criteria 
for its Category, it may be disqualified. 

What happens if I select the “wrong” 
Category? 

If the Judges determine that an image does not meet the 
criteria for its Category, it may be disqualified. 

To avoid this, if you are unsure which Category to select, 
please consult with one of the CCR Board Members for 
advice before submitting your images. 

https://www.cameraclubofrichmond.com/image-evaluations
https://www.cameraclubofrichmond.com/ccr-directors.pdf
https://www.cameraclubofrichmond.com/ccr-directors.pdf
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My Question: The Answer: 

May I enter more than one image in a 
Category? 

Yes. There is no restriction on putting multiple images into 
a single Category. You could put all twelve images into the 
same Category if you so choose. 

May I enter one image into multiple 
Categories or Color Designations? 

No. An image should be submitted only one time. You may 
not submit the same image into two different Categories 
nor as both B&W and Color. 

May I change the title of my Standard 
Image? 

No. The title of a Standard Image must be exactly the 
same title used in the Image Evaluation.  

Is there any exception to the titling rule? Yes, there is one exception: 

An image title may be changed if the Evaluator specifically 
suggested a name change. 

If you choose to make this change, you MUST notify the 
Digital Director with the old and new titles. 

What are the rules relating to Assigned 
Subjects? 

Images submitted in an Assigned Subject Category, must 
have been submitted in that Assigned Subject Category at 
the Image Evaluation for that subject. There are no post-
processing restrictions on Assigned Subject images, so BE 
CREATIVE! 

May I enter a Wildcard into an Assigned 
Subject Category? 

No. A Wildcard will not be accepted for any of the 
Assigned Subject Categories. All Assigned Subject 
images MUST have been submitted to the Evaluation for 
that Assigned Subject (thus they must be named as 
“Standard” images.) 

May I incorporate adjustments suggested by 
an Evaluator into the final image submitted 
for EOY Competition? 

Yes. Minor adjustments suggested by the Evaluator are 
permitted. The revised image must originate from the same 
source file. 

May I add a digital frame to my jpg for EOY 
Competition? 

Yes. If you wish to add a digital frame to your image for the 
EOY Competition, this is allowed. Check out our YouTube 
video by Anthony Rumley for instructions. 

What other adjustments may I make to my 
images? 

Images in the six “General” Categories may be enhanced, 
but these manipulations must be kept to a minimum and 
used only to enhance the existing image and ensure 
realism, such as with: levels, exposure, tonal changes, 
sharpening, cloning (for minor retouching).  

You are free to make any adjustments to images submitted 
in the “Creative Art” and “Assigned Subject” Categories. 

https://www.cameraclubofrichmond.com/image-evaluations
https://www.youtube.com/watch?v=iGLlhrQyf_M&t=9s
https://www.youtube.com/watch?v=iGLlhrQyf_M&t=9s
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My Question: The Answer: 

May I re-submit an image that has been 
submitted in a prior, CCR EOY Competition? 

Yes. You may re-submit an image if the image did not win 
any Awards in a prior, CCR EOY Competition. 

When is the Submission Deadline for the 
digital version of ALL images? 

The EOY Deadline for ALL digital images is 
Midnight, October 15, 2022. 

What are Credits? Awards earned in the EOY Competition are assigned 
“Credits”: 

• 1st Place = 3 Credits 

• 2nd Place = 2 Credits 

• 3rd Place = 1 Credit 

• Honorable Mention = 0 Credits 

• Major Awards = 0 Credits (since they have already 
received 3 Credits for earning 1st Place) 

Photographers will accumulate “Credits” to determine when 
they will graduate to a higher Group. 

Records are kept beginning with the 2021 EOY 
Competition and are cumulative within each Group for 
a running 3-year timeframe.  

Credits earned as a “Novice/Intermediate” are used to 
determine when to move to “Advanced.” Once there, you 
begin again with “0” and accumulate “Advanced Credits” to 
determine when you move to “Expert”. 

What is Minimum Total Score (MTS)? The Minimum Total Score (MTS) is the point threshold 
you must achieve to earn an EOY Award.  

The Novice/Intermediate Group’s score threshold is lower 
than the Advanced Group’s, and the Expert Group has the 
highest score requirement.  

Utilizing the Judges’ scores, the EOY Team applies these 
Minimum Total Score thresholds, so that ALL qualifying 
images that score this number of Points and above are 
recognized within each Judging Block.  

As Judges – and therefore scores - vary from year-to-
year, final MTSs for each Group will be determined by 
the CCR Board after the judging so that approximately 
20-25% of the images will receive Awards. 

If no entries within a Category reach the Minimum Total 
Score threshold, then no Awards will be given. 

 


